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Executive summary

The European Space Agency (ESA) Climate Change Initiative (CCI) is a global monitoring program, 
which aims to provide long-term satellite-based products to serve the climate modelling and climate  
user community. The objective of the ESA CCI Permafrost project (Permafrost_cci) is to develop and 
deliver the required Global Climate Observation System (GCOS) Essential Climate Variables (ECV) 
products, using primarily satellite imagery. The two main products associated to the ECV Permafrost,  
Ground  Temperature  (GT)  and  Active  Layer  Thickness  (ALT),  were  the  primary  documented 
variables during Permafrost_cci Phase 1 (2018–2021).  Following the ESA Statement of Work for 
Permafrost_cci  Phase  2  (2022–2025)  [AD-1],  GT  and  ALT  are  complemented  by  a  new  ECV 
Permafrost  product:  Rock  Glacier  Velocity  (RGV).  This  document  focuses  on  the  mountain 
permafrost component of the Permafrost_cci project and the dedicated rock glacier products.  

In  periglacial  mountain  environments,  permafrost  occurrence  is  patchy,  and  the  preservation  of 
permafrost  is  controlled  by  site-specific  conditions,  which  require  the  development  of  dedicated 
products as a complement to GT and ALT measurements and permafrost models. Rock glaciers are the 
best  visual  expression  of  the  creep  of  mountain  permafrost  and  constitute  an  essential  
geomorphological  heritage  of  the  mountain  periglacial  landscape.  Their  dynamics  are  largely 
influenced by climatic factors. There is increasing evidence that the interannual variations of the rock 
glacier creep rates are influenced by changing permafrost temperature, making RGV a key parameter  
for cryosphere monitoring in mountain regions. 

Two product types are therefore proposed by Permafrost_cci Phase 2: Rock Glacier Inventory (RoGI) 
and Rock Glacier Velocity (RGV). This agrees with the objectives of the International Permafrost 
Association  (IPA)  Standing  Committee  on  Rock  Glacier  Inventories  and  Kinematics (RGIK) 
(www.rgik.org) and concurs with the recent GCOS and GTN-P decisions to add RGV time series as a 
new product of the ECV Permafrost to monitor changing mountain permafrost conditions [AD-2 to 
AD-4].  RoGI is an equally valuable product to document past and present permafrost extent. It is a 
recommended first step to comprehensively characterise and select the rock glacier units to be used for 
RGV monitoring.  RoGI and RGV products also form a unique validation dataset for modelling in 
mountain regions, where direct permafrost measurements are very scarce or lacking.  Using satellite 
remote sensing, generating systemic RoGI at the regional scale and documenting RGV interannual 
changes  over  many  landforms  become  feasible.  Within  Permafrost_cci,  we  mostly  use  Synthetic 
Aperture Radar Interferometry (InSAR) technology based on Sentinel-1 images,  which provides a 
global coverage, a large range of detection capability (mm–cm/yr to m/yr) and fine spatio-temporal 
resolutions (tens of m pixel size and 6–12 days of repeat-pass). InSAR is complemented at some 
locations by SAR offset tracking techniques and spaceborne/airborne optical photogrammetry.

This Product User Guide (PUG) describes the properties of the rock glacier products from the Climate 
Research Data Package (CRDP) from Permafrost_cci Phase 2 iteration 1 [RD-6] and iteration 2 [RD-
7].  We specify  the  spatio-temporal  resolutions  and coverages,  the  formats,  the  attributes  and the 
known limitations of the RoGI and RGV products.
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1 Introduction

1.1 Purpose of the document

The mountain permafrost  component of Permafrost_cci Phase 2 focuses on the generation of two 
products: Rock Glacier Inventory (RoGI) and Rock Glacier Velocity (RGV). The Product User Guide 
(PUG) provides to the users the description of  the data properties,  formats,  attributes and known 
limitations of the mountain permafrost Climate Research Data Package (CRDP) [RD-6] [RD-7].

1.2 Structure of the document

Section  1  provides  information  about  the  purpose  and  background  of  this  document. Section  2 
describes the properties of the RoGI products. Section 3 describes the properties of the RGV products.  
A bibliography complementing  the  applicable  and reference  documents  (Sections  1.3  and 1.4)  is 
provided in Section 4.1. A list of acronyms is provided in Section 4.2. A glossary of the commonly 
accepted permafrost terminology can be found in [RD-18].

1.3 Applicable documents

[AD-1] ESA. 2022. Climate Change Initiative Extension (CCI+) Phase 2 – New Essential Climate 
Variables – Statement of Work. ESA-EOP-SC-AMT-2021-27.

[AD-2] GCOS. 2022. The 2022 GCOS Implementation Plan. GCOS – 244 / GOOS – 272. Global 
Observing Climate System (GCOS). World Meteorological Organization (WMO).

[AD-3] GCOS. 2022. The 2022 GCOS ECVs Requirements. GCOS – 245. Global Climate Observing 
System (GCOS). World Meteorological Organization (WMO).

[AD-4] GTN-P.  2021.  Strategy  and  Implementation  Plan  2021–2024  for  the  Global  Terrestrial 

Network  for  Permafrost  (GTN-P).  Authors:  Streletskiy,  D.,  Noetzli,  J.,  Smith,  S.L.,  Vieira,  G., 
Schoeneich, P., Hrbacek, F., Irrgang, A.M. 

1.4 Reference Documents

[RD-1] Rouyet, L., Pellet, C., Schmid, L., Echelard, T., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A.,  Poncos,  V.,  Kääb,  A,  Strozzi,  T.,  Bartsch,  A. 2024.  ESA CCI+ Permafrost  Phase 2  – CCN4 
Mountain Permafrost: Rock Glacier inventories (RoGI) and Rock glacier Velocity (RGV) Products.  
D1.1 User Requirement Document (URD), v2.0. European Space Agency.

[RD-2] Rouyet, L., Schmid, L., Pellet, C., Echelard, T., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A., Poncos, V., Kääb, A, Strozzi, T., Bernhard, P., Bartsch, A. 2024. ESA CCI+ Permafrost Phase 2 – 
CCN4 Mountain  Permafrost:  Rock Glacier  inventories  (RoGI)  and Rock glacier  Velocity  (RGV) 
Products. D1.2 Product Specification Document (PSD), v2.0. European Space Agency.

[RD-3] Rouyet, L., Pellet, C., Schmid, L., Echelard, T., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A., Poncos, V., Wendt, L., Lauknes, T. R., Kääb, A, Strozzi, T., Bernhard, P., Bartsch, A. 2024. ESA 
CCI+ Permafrost Phase 2 – CCN4 Mountain Permafrost: Rock Glacier inventories (RoGI) and Rock 
glacier  Velocity  (RGV)  Products.  D2.2  Algorithm  Theoretical  Basis  Document  (ATBD),  v2.0. 
European Space Agency.

[RD-4] Rouyet, L., Pellet, C., Schmid, L., Echelard, T., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A., Poncos, V., Wendt, L., Lauknes, T. R., Kääb, A, Strozzi, T., Bernhard, P., Bartsch, A. 2024. ESA 

6



4.2 Product  CCI+ Permafrost Phase 2 Issue 2.1

User Guide RoGI & RGV 16 January 2026

CCI+ Permafrost Phase 2 – CCN4 Mountain Permafrost: Rock Glacier inventories (RoGI) and Rock 
glacier Velocity (RGV) Products. D2.3 End-to-End ECV Uncertainty Budget (E3UB), v2.0. European 
Space Agency.

[RD-5] Rouyet, L., Pellet, C., Schmid, L., Echelard, T., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A., Poncos, V., Wendt, L., Lauknes, T. R., Kääb, A, Strozzi, T., Bernhard, P., Bartsch, A. 2024. ESA 
CCI+ Permafrost Phase 2 – CCN4 Mountain Permafrost: Rock Glacier inventories (RoGI) and Rock 
glacier Velocity (RGV) Products. D2.5 Product Validation Plan (PVP), v2.0. European Space Agency.

[RD-6] Rouyet, L., Echelard, T., Schmid, L., Pellet, C., Delaloye, R., Onaca, A., Sirbu, F., Poncos, V., 
Brardinoni, F., Kääb, A, Strozzi, T., Jones, N., Bartsch, A. 2023. ESA CCI+ Permafrost Phase 2  – 
CCN4 Mountain  Permafrost:  Rock Glacier  inventories  (RoGI)  and Rock glacier  Velocity  (RGV) 
Products. D3.2 Climate Research Data Package (CRDP), v1.0. European Space Agency.

[RD-7] Rouyet, L., Pellet, C., Echelard, T., Schmid, L., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A., Poncos, V., Brardinoni, F., Wendt, L., Lauknes, T. R., Kääb, A, Strozzi, T., Bernhard, P., Bartsch, 
A. 2025. ESA CCI+ Permafrost Phase 2  – CCN4 Mountain Permafrost:  Rock Glacier inventories 
(RoGI) and Rock glacier Velocity (RGV) Products. D3.2 Climate Research Data Package (CRDP), 
v2.0. European Space Agency.

[RD-8] Rouyet, L., Pellet, C., Echelard, T., Schmid, L., Delaloye, R., Brardinoni, F., Sirbu, F., Onaca,  
A., Poncos, V., Brardinoni, F., Wendt, L., Lauknes, T. R., Kääb, A, Strozzi, T., Bernhard, P., Bartsch, 
A. 2025. ESA CCI+ Permafrost Phase 2  – CCN4 Mountain Permafrost:  Rock Glacier inventories 
(RoGI) and Rock glacier Velocity (RGV) Products.  D4.1 Product Validation and Intercomparison 
Report (PVIR), v2.0. European Space Agency.

[RD-9] Rouyet, L., Echelard, T., Schmid, L., Pellet, C., Delaloye, R., Onaca, A., Sirbu, F., Poncos, V., 
Brardinoni,  F.,  Kääb,  A,  Strozzi,  T.,  Bartsch,  A. 2025.  ESA CCI+ Permafrost  Phase  2  – CCN4 
Mountain Permafrost: Rock Glacier inventories (RoGI) and Rock glacier Velocity (RGV) Products.  
D4.2 Product User Guide (PUG), v1.0. European Space Agency.

[RD-10] RGIK.  2023.  Guidelines for inventorying rock glaciers:  baseline and practical 
concepts (version 1.0). IPA Action Group Rock glacier inventories and kinematics, 25 pp. 
https://doi.org/10.51363/unifr.srr.2023.002.
[RD-11] RGIK. 2023. InSAR-based kinematic attribute in rock glacier inventories. Practical InSAR 
guidelines (version 4.0). IPA Action Group Rock glacier inventories and kinematics, 33 pp.

[RD-12] RGIK 2023. Rock Glacier Velocity as an associated parameter of ECV Permafrost: baseline 
concepts (version 3.2). IPA Action Group Rock glacier inventories and kinematics, 12 pp. 

[RD-13] RGIK. 2023. Rock Glacier Velocity as an associated parameter of ECV Permafrost: practical  
concepts (version 1.2). IPA Action Group Rock glacier inventories and kinematics, 17 pp. 

[RD-14] RGIK.  2023.  Instructions  of  the  RoGI  exercises  in  the  Goms  and  the  Matter  Valley 
(Switzerland). IPA Action Group Rock glacier inventories and kinematics, 10 pp.

[RD-15] Bertone, A., Barboux, C., Bodin, X., Bolch, T., Brardinoni, F., Caduff, R., Christiansen, H.  
H., Darrow, M. M., Delaloye, R., Etzelmüller, B., Humlum, O, Lambiel, C., Lilleøren, K. S., Mair, V.,  
Pellegrinon, G.,  Rouyet,  L.,  Ruiz, L.,  Strozzi,  T. 2022. Incorporating InSAR kinematics into rock 
glacier  inventories:  insights  from  11  regions  worldwide.  The  Cryosphere.  16,  2769–2792. 
https://doi.org/10.5194/tc-16-2769-2022. 

[RD-16] Pellet,  C.,  Bodin,  X.,  Cusicanqui,  D.,  Delaloye,  R.,  Kaufmann,  V.,  Noetzli,  J., 
Thibert, E., Vivero, S., & Kellerer-Pirklbauer, A. (2024). Rock glacier velocity. In Bull. Amer. 
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Soc.  Vol.  105(8),  State  of  the  Climate  in  2023,  pp.  44–45. 
https://doi.org/10.1175/2024BAMSStateoftheClimate.1.

[RD-17] Adler, C., P. Wester, I. Bhatt, C. Huggel, G.E. Insarov, M.D. Morecroft, V. Muccione, and 
A. Prakash. 2022. Cross-Chapter Paper 5: Mountains. In: Climate Change 2022: Impacts, Adaptation 
and  Vulnerability.  Contribution  of  Working  Group  II  to  the  Sixth  Assessment  Report  of  the 
Intergovernmental Panel on Climate Change. Cambridge University Press, Cambridge, UK and New 
York, NY, USA, pp. 2273–2318. https://doi.org/10.1017/9781009325844.022.

[RD-18] van Everdingen, R. Ed. 1998, revised in May 2005. Multi-language glossary of permafrost  
and related ground-ice terms. Boulder, CO: National Snow and Ice Data Center/World Data Center for 
Glaciology. http://nsidc.org/fgdc/glossary.
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2 Rock glacier inventory (RoGI) products

2.1 Background and terminology

The Rock Glacier Inventory (RoGI) products of the Permafrost_cci Phase 2 iteration 1 have been 
generated during a multi-operator exercise performed between June and November 2023. The exercise 
was performed in 12 areas selected in 10 countries and 5 continents (see PSD [RD-2] and CRDP [RD-
6]).  A Principal Investigator (PI) was designated to coordinate the work in each area.  The inventory 
teams were composed of 5 to 10 operators (incl. the PI). The exercise involved in total 41 persons. The 
work was  performed in similar QGIS projects,  with common file structure,  background data,  and 
dialog boxes for semi-automatic attribute filling (see ATBD [RD-3]). The inventorying procedure 
follows up on prior work aiming to reduce discrepancies between different operators and produce 
homogenous consensus-based RoGI (e.g. Brardinoni et al., 2019; Way et al., 2021). The work was 
performed in two main phases between June and November 2023:
 Phase 1 (June–Sept. 2023): The operators individually identified Rock Glacier Units (RGUs) with 

Primary Markers (PMs) and detected potential Moving Areas (MAs) based on Synthetic Aperture 
Radar Interferometry (InSAR) data. The PI compared the individual results and suggested a final  
solution. After discussion during an online meeting between operators, consensus-based PM/MA 
layers were adopted.

 Phase  2  (Sept–Nov.  2023):  Based on the  consensus-based results  from Phase  1,  the  operators 
outlined and documented the RGU morpho-kinematics characteristics. The PI compared the results 
and suggested a final solution. After discussion during a second online meeting between operators, 
the consensus-based PM layer (incl.  attributes) and the Geomorphological  Outlines (GO layer) 
were adopted.

In the CRDP from Permafrost_cci Phase 2 iteration 1 [RD-6], the delivered products included the final 
consensus-based products (names formatted as described in Section 2.10). The data package comprises 
three types of files:
 The Primary Markers (PMs), i.e. the points identifying and locating rock glaciers within the 12  

areas.  “Certain”  and  “Uncertain”  RGUs  can  be  differentiated  and  landforms  that  could  be 
misinterpreted as rock glaciers but are not attributed to permafrost creep (e.g. glacial features,  
solifluction lobes, landslides) have in some cases been highlighted with an extra category “not a 
rock  glacier”.  Attributes  documenting  the  morpho-kinematic  characteristics  of  the  identified 
landforms are assigned to each “Certain” RGU.

 The Moving Areas (MAs), i.e. the polygons detected, delineated, and characterized (assignment 
of a velocity class) using Synthetic Aperture Radar Interferometry (InSAR) data. The MA files 
were used to categorize the kinematic attribute in the PM files.

 The Geomorphological Outlines (GOs), i.e. the polygons outlining the restricted and/or extended 
geomorphological footprints of the rock glacier units categorized as “Certain”.

Common instructions for inventorying were delivered to all operators. They are summarised in the 
ATBD [RD-3] and follow the guidelines defined by the International Community on Rock glacier  
Inventories and Kinematics (RGIK) [RD-10] [RD-11].
The RoGI production in Permafrost_cci Phase 2 iteration 2 follows the same RoGI guidelines. The  
CRDP version 2.0 [RD-7] includes new RoGI products that have the same properties and formats as in 
the previous iteration.
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2.2 Input data

Each RoGI folder delivered to the operators included: 1) the subfolder “INSTRUCTIONS” with the 
documents  and  links  to  applicable  guidelines;  2)  the  subfolder  “VECTOR”  includes  the  initial  
GeoPackages (gpkg) templates for digitalizing the PMs, MAs and GOs; 3) the subfolder “INSAR-
DATA”  including  wrapped  interferograms  from  Sentinel-1  (and  where  available  from  ALOS, 
SAOCOM,  Cosmo-SkyMed,  and/or  TerraSAR-X),  potential  complementary  InSAR  products 
processed  with  alternative  methods  (e.g.  velocity  maps  from  Stacking  or  Persistent  Scatterer 
Interferometry algorithms), a layer displaying an index to reproject the LOS displacement along the  
direction of the steepest slope (normalization factor) or a mask highlighting N–S facing slopes where 
the movement is  likely to be underestimated on InSAR data;  4) the QGIS project  structuring the 
available data and in which the operators performed the work. In addition to the InSAR data and initial 
vector files (gpkg templates), each GIS project incorporates links to Web Map Services (WMS) such 
as the Google Earth, Bing and ESRI orthoimages. Before delivery to the operators, some PIs have 
added  additional  data  (high-resolution  DEMs-based  products  and  orthophotos  available  at  the  PI 
institutions or from other national/regional mapping services).

2.3 Temporal coverage

Rock glaciers identification (PM points) and outlining (GO polygons) are performed using the most 
recent  optical  imagery  from  Google  Earth,  Bing  and  ESRI  WMS,  potentially  complemented  by 
national/regional  datasets  (additional  high-resolution  DEMs-based  products  and  orthophotos).  The 
imagery date varies between the areas but was similar within each inventory team.
MA polygons are spatially identified and characterised using InSAR images acquired during the snow-
free periods. The velocity class assigned to the MAs is expressed in cm/yr. Sentinel-1 was the primary 
data source with images between 2016 and 2022. Additional data based on ALOS, SAOCOM, Cosmo-
SkyMed and TerraSAR-X SAR sensors were used where/when available.
The kinematic attribute refers to a category of annual velocity, expressed in cm/yr, dm/yr or m/yr.  
Specific translation rules are followed to derive the rock glacier kinematic attributes from the original 
velocity classes of the MAs. These rules are defined in the InSAR guidelines [RD-11], also described 
in the ATBD [RD-3].

2.4 Spatial coverage

The exercise was performed in 12 areas selected in Romania, Switzerland, Norway, France, Italy, 
Greenland (Danmark), Kazakhstan, Alaska (USA), Argentina and New Zealand (see PSD [RD-2] and 
CRDP [RD-6]). The size of the studied areas varies between 7 and 82 km2. As part of iteration 2, RoGI 
products are generated in 8 additional regions in Switzerland, Italy, Bulgaria, Nepal, Bolivia-Chile, 
Mongolia, India, Bhutan. The size of the studied areas varies between 188 and 2672 km2. The InSAR 
data were clipped to the AOI extent. However, the actual coverage of interpretable InSAR information 
depends on the signal quality (e.g. low on wet, snow-covered, or vegetated surfaces), as well as on the  
topography in respect to the sensor viewing geometry. Some areas cannot be documented with InSAR 
due to  low coherence (decorrelation of  the  interferometric  signal),  layover  or  shadow.  When the  
coverage was reduced on specific rock glaciers, the kinematic attribute remained “Undefined”.
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2.5 Temporal resolution

The temporal resolution of the InSAR data depends on the repeat-pass of the SAR sensor and the time  
interval used to generate the interferograms. For Sentinel-1, the maximal temporal resolution is 6 days. 
Fast movements were identified using summer interferograms, using time intervals from 6 days up to 
several months. Slow movements were identified using annual interferograms computed between two 
or more consecutive summers. 

2.6 Spatial resolution

The recommended minimum size of rock glaciers to be included in a RoGI is about 0.01 km2 [RD-10]. 
The primary marker positioning on the rock glacier should avoid, as far as possible, any temporal 
variation and updating. The point must be located somewhere in the lower half of the rock glacier unit  
[RD-10]. Optical aerial/satellite images and DEMs were used to morphological interpretation and rock 
glacier delineation (outlines). The resolution typically varies between < 0.5 m and a couple of meters 
depending on the data sources used for generating the orthomosaics in the WMS services, and the 
potential  use  of  additional  high-resolution  datasets.  Moving  areas  related  to  the  inventoried  rock 
glaciers  were  outlined primarily  based on Sentinel-1  InSAR products  (20–40 m final  resolution). 
Additional InSAR products with higher resolution (e.g. 3–10 m final resolution for CosmoSky-Med 
and TerraSAR-X) were used when available.

2.7 Product accuracy

Permafrost_cci Phase 2 RoGI are produced following a morpho-kinematic approach for which both 
rock glaciers that are moving and those that are not moving were identified. The movement rates of 
the  active  rock  glaciers  were  documented  using  InSAR,  primarily  based  on  the  Sentinel-1  SAR 
satellites. Rock glaciers that are not moving have also been morphologically identified. They are either 
characterized with a kinematic attribute < cm/yr or remain kinematically undefined, depending on the 
InSAR signal quality. Minimum detectable displacement rates from Sentinel-1 InSAR are in the order 
of 1/10 of a wavelength (i.e.  around 5–6 mm). For time intervals of 48–6 days, this translates to 
minimum detectable rates of around 4–34 cm/yr, respectively. Slower displacements can be detected 
using annual or bi-annual temporal baseline. Maximum detectable displacement is limited by phase 
coherence loss due to high deformation and are in the order of 1/2 wavelength (i.e. around 2.8 cm) 
during the time interval used to build the interferograms, i.e. 20–170 cm/yr for time intervals of 48–6 
days. For a specific time interval, a movement rate higher than the maximal detectable value appears  
decorrelated on the interferogram. In this case, a moving area can be drawn but the velocity class 
remains undefined [RD-11].

The product accuracy is documented according to the Goal Requirement of URq_10 [RD-1]. For the 
moving areas, the reliability of the detection is qualitatively estimated (low, medium, high) based on 
the difficulty to interpret the signal and/or delineate the moving area. Similarly, the kinematic attribute 
of  the rock glacier  units  is  documented with low, medium and high categories depending on the 
quality  and  the  spatial  representativeness  of  the  detected  MAs.  The  reliability  of  the  outlines  is 
estimated with a scale from 0 (low) to 2 (high) for each boundary (front, lateral margins and upslope 
limit),  and  summed  up  to  give  a  reliability  estimate  for  the  entire  landform. The  sources  of 
uncertainties  are  further  described  in  ‘Comments’  fields.  Discussion  about  product  accuracy  and 
uncertainties are further detailed in Rouyet et al. (2025b).

11



4.2 Product  CCI+ Permafrost Phase 2 Issue 2.1

User Guide RoGI & RGV 16 January 2026

2.8 Product projection system

The Coordinate Reference System (CRS) used for the RoGI products is the World Geodetic System 
1984 (WGS84). The coordinates are specified in decimal degrees. 

2.9 File format and size

All datasets are provided in a geopackage vector format (.gpkg). The total data volume is 10.2 MB.

2.10 Product file naming convention

ESACCI-<CCI  Project>-<Processing  Level>_<Data  Type>_<Product  String>-<Additional 
Segregator>_<Layer Type>_<Indicative Date>-fv<File version>.gpkg

<CCI Project>
PERMAFROST for Permafrost_cci

<Processing Level>
Indicator (IND)

<Data Type>
This should be structured as: <SENSOR>-<METHOD>
<SENSOR> is the primary remote sensing data source used to document the kinematics, in this case: 
SENTINEL-1. <METHOD> is the primary method used to process the data, in this case: INSAR.

<Product String>
ROGI, when the product is Rock Glacier Inventory.

<Additional Segregator>
This should be structured as: AREA_<REGION_NUMBER>-<AREA_NUMBER>.
<REGION_NUMBER> follows the same numbering has for Permafrost_cci Phase 1: 5–Carpathians 
(Romania);  6–Western  Alps  (Switzerland);  7–Troms  (Norway);  8–Finnmark  (Norway);  9–
Nordenskiöld  Land (Svalbard);  10–Vanoise  Massif  (France);  11–Venosta  (Italy);  12–Disko Island 
(Greenland); 13–Tien Shan (Kazakhstan); 14–Brooks Range (Alaska); 15–Central Andes (Argentina); 
16–Southern Alps (New Zealand);  17–Pirin and Rila  (Bulgaria);  18–Manaslu (Nepal);  19–Sajama 
(Bolivia–Chile); 20–Tsengel Khairbkhan (Mongolia); 21–Baralacha La (India); 22–Thana (Bhutan).
<AREA_NUMBER> is a one or more digit(s) number, depending on the area(s) in the region.

<Layer Type>
The individual layers of the vector product are provided as different files. The code of each layer is as 
followed:
 PM: layer 1, corresponding to the rock glacier primary markers
 MA: layer 2, corresponding to the associated moving areas
 GO: layer 3, corresponding to the geomorphological outlines of the rock glaciers

<Indicative Date>
Format is YYYYMMDD, where YYYY is the four digits year, MM is the two digits month from 01 to 
12 and DD is the two digits day of the month from 01 to 31. Annual or multi-annual products are  
represented with YYYY only.

fv<File Version>
File version number in the form n{1,}[.n{1,}] (two digits followed by a point and one or more digits).
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Example:
ESACCI-PERMAFROST-IND_SENTINEL1-INSAR_ROGI-AREA_6-1_PM_2025-fv01.0.gpkg

2.11 Attributes

For the RGU Primary Markers, the following attributes are documented: 
 ID (unique alpha-numerical identifier of the rock glacier unit).
 X and Y coordinates (WGS84 coordinate system).
 Morphological type (simple, complex).

Additional related attribute: the “Completeness” field defining if the rock glacier is complete 
visible or not (complete, unclear connection the upslope, truncated front, uncertain).

 Spatial  connection  to  the  upslope  unit  (talus-,  debris  mantle-,  landslide-,  glacier-,  glacier  
forefield-, poly-connected, other, uncertain, unknown).
Additional related attributes: the “Upslope Current” field defining if the rock glacier is currently 
connected to the upslope unit or not, and a “Comment” field to further describe morphological 
characteristics. 

 Kinematic  attribute  (<  cm/yr,  cm/yr,  cm/yr  to  dm/yr,  dm/yr,  dm/yr  to  m/yr,  m/yr,  >  m/yr, 
undefined).
Additional related attributes: the “Type of Data” field to define the type of data used to assign the 
kinematic  attribute  (Optical,  Radar,  Lidar,  Geodetic,  Other),  the  “Kinematic  Period”  field  to 
document  the  applicable  period  of  the  kinematic  attribute  (year(s)  with  available  data),  the 
Reliability of the kinematic attribute (low, medium, high, undefined) and a specific “Comment” 
field to further document the applied method and the data quality.

 Activity  (active,  active  uncertain,  transitional,  transitional  uncertain,  relict,  relict  uncertain,  
uncertain) and the “Activity Assessment” field documenting how the activity has been assessed 
(morphological evidence only or with kinematic data).

 Destabilization signs (yes - ongoing, yes - completed, no, undefined).

For the Moving Areas, the following attributes are documented:
 ID (unique alpha-numerical identifier of the moving area)
 Velocity class (< 1 cm/yr, 1–3 cm/yr, 3–10 cm/yr, 10–30 cm/yr, 30–100 m/yr, > 100 cm/yr).
 Time  observation  window  (text  documenting  the  time  window  when  the  detection  and 

characterization of the moving area has been performed).
 Reliability of the detected moving area (low, medium, high).
 Additional comments.

For the Geomorphological Outlines, the following attributes are documented:
 ID (unique alpha-numerical identifier of the outline).
 Outline type (extended, restricted, other).
 Reliability of the front, the left margin, the right margin, and upslope limit (2 – high, 1 – medium, 

0 – low) and Reliability Index (automatic summation of the values assigned to the reliability 
attributes of these four different boundaries).

 Additional comments.

Each attribute was explained into detail in the instructions of the RoGI exercise (incl. references to the  
applicable sections of the RGIK guidelines). These explanations are also reported in the ATBD [RD-
3].
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2.12 Metadata

Building on the PUG, a metadata file is available in the Zenodo data repository (Rouyet et al., 2025a) 
and in the associated data description paper published in Earth System Science Data (ESSD) (Rouyet  
et al., 2025b). The metadata includes information about the type and properties of the input data: the 
orthoimages, the DEMs and the SAR satellite scenes used for InSAR analysis: The name of the PI and 
the  reference  time  period  of  the  RoGI  production  are  reported.  References  to  be  cited, 
acknowledgments and any other important metainformation are mentioned.

2.13 Known limitations

The quality of the data sources has an obvious impact on the quality of the final RoGI products. For 
the geomorphological characterization of the rock glaciers, the variable availability and quality of the  
optical  and  topographical  data  led  to  different  levels  of  details  and  uncertainties  between the  12 
selected areas.

A similar observation applies to the InSAR interpretation. In some areas (e.g. extra-European), only 
12-days Sentinel-1 repeat-pass is available in the archive. The availability of InSAR data based on 
complementary SAR sensors or alternative processing algorithms also varies from area to area. The 
fewer the variety of available InSAR data with complementary coverages, detection capabilities and 
resolutions, the higher the uncertainty of the moving area delineation and characterisation. In general,  
slow movements were investigated mainly using annual interferograms. However, using long-time 
intervals, the quality of the single wrapped interferograms gets sometimes lower, due to loss of phase 
coherence. The number of suitable interannual interferograms is generally lower than the number of 
suitable interferograms with shorter time intervals. Slow movements are therefore more complicated 
to analyse, and the MA reliability is consequently lower. However, for some areas characterized by 
slow-moving features (e.g. Carpathians in Romania and Finmark in Norway), additional InSAR data 
more suitable for low velocity (e.g. processed with PSI) were delivered to the operators to overcome 
this issue.

Many operators took part to the exercise (in total 41 persons). All have different backgrounds and 
variable experience in inventorying rock glaciers and working with InSAR data.  This diversity is  
positive when applying a consensus-based approach but is also challenging to provide a homogenous 
dataset and systematically analyse the results (individual files against the final products). In many 
cases, the individual results are partial: some operators did not dare to assess elements for which they  
had weaker experience, or they had not enough time to do all the steps. The reliability fields are highly 
subjective and the way to assess this attribute varies from an operator to an operator. However, in the 
final  product,  this  limitation  is  overcome  by  systematic  documentation  by  the  PI  and  good 
commenting in the remark fields. The final reliability assessment is consistent within each RoGI.

The InSAR interpretation (MA and resulting kinematic assessment in the PM attribute table) was the 
most challenging step according to all  the PIs of the exercise. Suggestions to solve that issue are 
discussed in Rouyet et al.  (2025b). For other inventorying steps and attribute characterisation, the  
multi-operator exercise allowed to identify elements that need to be better explained and exemplified 
in the guidelines (e.g. how to draw the upper outline, difference between “Uncertain” and “Unknown” 
upslope  connection,  relevance  and  applicability  of  the  “Upslope  Current”  field).  Minor  technical 
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things  must  also  be  fixed  in  the  file/project  templates  (e.g.  intuitive  order  of  the  attributes,  
unambiguous standard layer colours). 

Technical limitations intrinsic to vectorization in GIS have been identified. Some bugs in the attribute  
tables (e.g. restricted numbers of character for specific fields) or the object geometries (e.g. polygons 
with self-intersections) led to partly corrupted files that limited the intercomparison possibilities of all  
operator files. These errors were fixed for the final products, which have been openly released (see 
Section 2.14).

2.14 Product version and data dissemination

The RoGI products from Permafrost_cci phase 2 iteration 1 have been openly released in the Zenodo 
data repository (Rouyet et al., 2025a;  https://doi.org/10.5281/zenodo.14501398). An associated data 
description paper has been published in Earth System Science Data (ESSD) (Rouyet et al., 2025b;  
https://doi.org/10.5194/essd-17-4125-2025).

The preliminary RoGI results in the new regions of Permafrost_cci Phase 2 iteration 2 have been 
delivered in May 2025 [RD-7]. The products are being finalized and will be published separately by 
each inventorying team, before to be compiled in the upcoming RGIK RoGI database.
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3 Rock glacier velocity (RGV) products

3.1 Background and terminology

Rock  glacier  velocity  (RGV)  is  defined  as  a  time  series  of  annualized  surface  velocity  values 
expressed in m/y and measured/computed on a rock glacier unit  or a part of it  [RD-12]. RGV is 
produced with the objective to document the long-term changes of rock glacier creep rate in a climate-
oriented perspective. RGV is a quantity of the ECV Permafrost aiming to complement the two other 
quantities  (permafrost  temperature  and  active  layer  thickness)  to  monitor  changing  permafrost  
conditions  in  mountains  [AD-2  to  AD-4].  Based  on  satellite  remote  sensing  techniques,  such  as 
InSAR, a RGV is the result of flow field measurements for pixels assumed to be representative of the  
permafrost  creep  of  the  rock  glacier  unit  (or  part  of  it)  [RD-12].  Temporally,  the  initial  InSAR 
measurements are aggregated during a consistent observation time window each year. 

The development of InSAR-based RGV products has been performed in synergy with the M.Sc. study 
of  Lea  Schmid  at  the  University  of  Fribourg  (UNIFR)  (Schmid,  2024).  After  a  pilot  stage 
(Permafrost_cci Phase 2 iteration 1), the InSAR procedure has been adjusted and tested on a large 
number of rock glaciers (Permafrost_cci Phase 2 iteration 2).

3.2 Input data

Sentinel-1 Single-Look Complex (SLC) SAR images in Interferometric Wide (IW) swath mode have 
been processed to  generate  interferograms with  a  6–12 days  temporal  baseline  between July  and 
October. The numbers of selected interferograms varies between years (6–19) but always cover the 
different months (early to late season). The observation time window is therefore consistent.

3.3 Temporal coverage

Using Sentinel-1 12-days temporal baselines, 2015–2024 (10 years) years have been processed. Using 
Sentinel-1 6-days temporal baselines, the temporal coverage is reduced to 2017–2021 (5 years). All 
time series are within the Breakground Requirement of URq_15 (5–10 years) [RD-1].

3.4 Spatial coverage

The  RGV  product  represents  the  InSAR  flow  field over  one  or  more  area(s)  representing  the 
downslope movement of a rock glacier unit (Goal Requirement of URq_17 [RD-1]).  Velocity time 
series are produced for several pixels across the Permafrost_cci sites to document the variability of the 
velocity patterns, evaluate these differences and potentially divide the landforms in areas affected by 
different  kinematics.  The  final  time  series  either  correspond  to  selected  pixel(s)  assumed  to  be 
representative of the landform behaviour,  or to a spatially averaged velocity based on  a group of 
pixels. For each site, the selected pixel(s) and/or the aggregation procedure (e.g. size and location of 
the considered area(s), number of pixels used to average the time series) are documented and remain 
consistent over time.

3.5 Temporal resolution

The  initial  velocity  data  is  based  on  Sentinel-1  InSAR time  series  with  a  6–12  days  frequency 
collected during snow-free periods for the years 2015–2024 (observation time window < 1 year but 
covering  at  least  one  month).  The  velocity  data  is  then  annualised,  following  the  URq_13 Goal 
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Requirement  [RD-1].  The observation time window is at least one month (between June–October), 
following the URq_14 Breakthrough Requirement  [RD-1].  The chosen period is  documented and 
consistent throughout the entire time series for each site (max. ±15 days of difference), as required by 
URq_14 [RD-1].

3.6 Spatial resolution

Sentinel-1 InSAR data used for RGV production has a 25 m resolution. The final products correspond 
several selected pixel(s), provided separately and/or averaged spatially, as described in Section 3.4.

3.7 Product accuracy

Based on a single interferogram procedure, the expected accuracy of Sentinel-1 InSAR is 6 to 7 mm 
for each measurement (Strozzi et al., 2020). The accuracy can go down to a mm accuracy using multi-
temporal InSAR, but these techniques are mostly applicable for slow-moving landforms. The accuracy 
is  expected  to  have  a  relative  error  lower  or  equal  to  10%,  correspond  to  the  Breakthrough 
Requirement of URq_18 [RD-1].

3.8 Product projection system

The Coordinate Reference System (CRS) used for the RGV products is the World Geodetic System 
1984 (WGS84). The coordinates are specified in decimal degrees. 

3.9 File format and size

All datasets are provided in comma-separated values (.csv) format. The data volume is 587 MB.

3.10 Product file naming convention

ESACCI-<CCI  Project>-<Processing  Level>_<Data  Type>_<Product  String>-<Additional 
Segregator>_<Indicative Date>-fv<File version>.csv

<CCI Project>
PERMAFROST for permafrost_cci

<Processing Level>
Indicator (IND)

<Data Type>
This should be structured as: <SENSOR>-<METHOD>
<SENSOR> is the primary remote sensing data source used to document the kinematics, in this case: 
SENTINEL-1. <METHOD> is the primary method used to process the data, in this case: INSAR.

<Product String>
RGV, when the product is Rock Glacier Velocity.

<Additional Segregator>
This should be structured as: <COUNTRY_CODE>-<SITE_NAME>.
<COUNTRY_CODE> currently includes: CH–Switzerland; FR-France; IT–Italy.
<SITE_NAME> currently  includes:  Bru;  Distelhorn;  GrossesGufer;  Réchy;  Steintälli;  Laurichard; 
GranSometta;  LaThuile;  Lazaun;  Luseney;  Moline;  MonteEmiliusRange1;  MonteEmiliusRange2; 
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NorthArpignan;  Rhemes;  Similaun;  ValGrisenche2;  ValGrisenche3;  Valnontey;  Valsavaranche1; 
Valavaranche3.

<Indicative Date>
Format is YYYYMMDD, where YYYY is the four digits year, MM is the two digits month from 01 to 
12 and DD is the two digits day of the month from 01 to 31. Annual products are represented with  
YYYY only.

fv<File Version>
File version number in the form n{1,}[.n{1,}] (two digits followed by a point and one or more digits).

Example:
ESACCI-PERMAFROST-IND_SENTINEL1-INSAR_RGV_CH-Diestelhorn_2025-fv01.1.csv

3.11 Attributes

For each RGV time series the following attributes are documented:
 ID (unique alpha-numerical identifier of the RGV time series).
 Reference ID of the related rock glacier unit (when a RoGI is available).
 Data and technique used (description of the platform, sensor type and processing approach).
 Area considered for RGV processing (area-based, several discrete points, three discrete points or 

one single discrete point, and related specifications).
 Start date (date of first observation).
 Velocity data (computed RGV data in m/yr).

For each velocity data (each annual increment of the time series), the following attributes are 
documented:
 ID (unique alpha-numerical identifier of the RGV data).
 Reference ID of the related RGV time series.
 Start date (start date of the observation time window).
 End date (end date of the observation time window).
 Base data (data/platform/sensor used for the data acquisition).
 Velocity data (computed RGV data in m/yr).
 Relative error of the velocity data (ideal: < 5%, medium: 5–20%, minimal: 20%).
 Consistency of the RGV time series (ideal: no problem with newly added velocity data, medium: 

problems with newly added velocity data but no major change of procedure, high: problems with  
newly added velocity data and major change of procedure).

 Comments  (documentation  of  any  changes  or  specific  aspect  of  the  data  production  worth 
archiving and relevant for the data analysis and usage).

3.12 Metadata

For each RGV, a separate documentation file is provided, building on the PUG. Each file indicates the  
data  and  methodology  used  for  deriving  the  RGV time  series,  as  well  as  additional  information 
regarding  the  observation  time  window,  the  temporal  and  horizontal  resolution,  and  the  spatio-
temporal aggregation procedure applied to provide the RGV. The producer and the date of production 
are indicated in the metadata file.
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3.13 Known limitations

In the first iteration of Permafrost_cci Phase 2, we showed that the proposed procedure was promising, 
and that the InSAR-RGV pilot products were overall consistent with similar GNSS-RGV products at  
the same sites. However, the few selected sites and the short overlapping periods between InSAR and  
GNSS measurements made it challenging to draw any definitive conclusion.

In the second iteration of Permafrost_cci Phase 2, RGV production was tested on a larger number of 
rock glaciers in the Alps (21 sites). The Product Validation and Intercomparison Report (PVIR) [RD-
8] discusses the identified limitations. The regional comparison show that the InSAR-RGV results 
highlight overall  similar trend comparable with GNSS-RGV. However,  the InSAR results show a 
variable  level  of  quality  depending on  the  site.  Many selected  areas  are  too  fast  to  ensure  good 
coherence. The high spatial heterogeneity of the signal also increases the risk of unwrapping errors 
that can significantly bias the results in fast-moving areas and fast-moving periods. The years with 
only 12d of Sentinel-1 (2015-2016 and 2022-2024) are even more vulnerable to this issue. For this 
reason, the expected 2015 velocity peak (based on GNSS data) is often not detected due to 12d repeat-
pass  and  too  high  velocity.  Due  to  identified  unwrapping  problems  for  many  sites,  a  spatial 
aggregation approach (averaging many pixels over the rock glacier) was not always feasible. In such 
cases, the InSAR-RGV products consist of documenting velocity changes for a few selected pixels 
over the rock glaciers. Remaining open questions on spatial representativeness need to be solved in the 
future,  which might  lead to  an  adjustment  of  the  procedure.  The impact  of  the  observation time 
window used for seasonal averaging also remains unclear. For rock glaciers with very strong seasonal  
variations, the temporal criteria to average the results to get the yearly velocity might be of high  
significance.

3.14 Product versions and data dissemination

The CRDP from Permafrost_cci Phase 2 iteration 2 [RD-7] has been delivered in May 2025. The data  
package is not openly released yet. The production is still ongoing to include a larger number of rock 
glaciers. Based on the latest conclusions of the product validation and intercomparison (see PVIR), the 
procedure for RGV generation might still be adjusted, which will lead to a new update of the CRDP 
and PUG.
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4.2 Acronyms

AD Applicable Document
AI Artificial Intelligence
ALT Active Layer Thickness
ADP Algorithm Development Plan
ATBD Algorithm Theoretical Basis Document
BR Breakthrough Requirement
CAR Climate Assessment Report
CCI Climate Change Initiative
CCN Contract Change Notice
CRDP Climate Research Data Package
DEM Digital Elevation Model
E3UB End-to-End ECV Uncertainty Budget
ECV Essential Climate Variable
EO Earth Observation
ESA European Space Agency
GAMMA Gamma Remote Sensing AG
GCOS Global Climate Observing System
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GNSS Global Navigation Satellite System
GR Goal Requirement
GT Ground Temperature
GTN-P Global Climate Observing System
GTOS Global Terrestrial Observing System
IANIGLA Instituto Argentino de Nivología, Glaciología y Ciencias Ambientale
InSAR Interferometric Synthetic Aperture Radar
IPA International Permafrost Association
KA Kinematic Attribute
LOS Line-of-sight
MA Moving Area
MAGT Mean Annual Ground Temperature
MAGST Mean Annual Ground Surface Temperature
NORCE Norwegian Research Centre AS
PERMOS Swiss Permafrost Monitoring Network
PI Principal Investigator
PM Primary Marker
PSD Product Specification Document
PUG Product User Guide
PVASR Product Validation and Algorithm Selection Report
PVIR Product Validation and Intercomparison Report
PVP Product Validation Plan
RD Reference Document
RG Rock Glacier
RGIK Rock Glacier Inventories and Kinematics
RGU Rock Glacier Unit
RGV Rock Glacier Velocity
RoGI Rock Glacier Inventory
RMSE Root Mean Square Error
SAR Synthetic Aperture Radar
UiO University of Oslo
UNIFR University of Fribourg
URD Users Requirement Document
URq User Requirement
UTM Universal Transverse Mercator
TR Threshold Requirement
WUT West University of Timisoara
WMO World Meteorological Organization
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